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Why Use 4W WebMerge?
Microsoft Access, FileMaker Pro, and other popular database tools offer great options for publishing 
your data on the Web. But those solutions require having the database serve the pages in real time, 
requiring specialized hosting services which can be expensive to set up and maintain.
It would be much easier if you could simply publish static Web pages from your database. With 
standard HTML pages you could publish your data on any Web server in the world, with no need for 
live database hosting.
Of course, you could do this by hand, and for a small number of records copying and pasting into your 
Web pages may work well enough. But once you get to 100 or more records you might want to think 
twice about the value of your time. That's where WebMerge comes in.
4W WebMerge lets you export your database records to a text file, and for each record in that file it 
makes a copy of a template page, replacing tags in the template with data from each record. 
WebMerge can do in seconds what would take hours or even days to do by hand. The Web pages 
WebMerge generates are just standard HTML - they can be uploaded to any server, even AOL.
If you need dynamic content customized for each visitor, or if you have thousands of records which 
would be prohibitive to upload to a server, you're probably better off looking into a dedicated 
database server solution. But for just about everything else, publishing static database content on 
the Web with WebMerge is about as easy and affordable as it can get.
In summary:

WebMerge is an easy, fast solution for publishing database content
Static pages don't require any special web hosting – any web server will work
Static pages load faster than pages generated dynamically from a database
Reports indicate that static web pages are more thoroughly indexed in major search engines
With its automation features WebMerge can integrate into a variety of web production 
workflows
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System Requirements

 Windows

Windows 95/98/NT/2K/ME/XP
64 MB total system memory
6 MB disk space
800 x 600 min. screen
resolution

 Mac OS X

System 10.2 or later
64 MB total system memory
6 MB disk space
800 x 600 min. screen
resolution
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Overview of the Process
Working with WebMerge involves three main tasks:

Create Your Source File
Any program that exports tab-delimited or Merge formats can be used to create 
publishable source files for WebMerge. These include FileMaker Pro, Microsoft Access 
and Excel, AppleWorks, and nearly every other database or spreadsheet program. 
To use the data from those programs in WebMerge, just export it in either Merge or 
tab-delimited format. FileMaker Pro and Microsoft Access both offer Merge as an option 
for exporting, as do many other database tools. Nearly all database and spreadsheet 
programs will export in a tab-delimited format. See Preparing Your Source File for 
details.
If you're a member of an affiliate program most such programs provide a delimited feed 
suitable for use with WebMerge. WebMerge can work with nearly any columnar format, 
including tab-delimited, CSV, pipe-delimited, and others.

Prepare your Template Pages
You can make templates for your Web pages using your favorite Web authoring tool, 
including Dreamweaver, GoLive, BBEdit, or even Word Pad. You'll add simple placeholder 
tags into your HTML, and WebMerge replaces those tags with the corresponding data 
from your source file. If you need to publish instantly you can even have WebMerge 
create a set of basic templates for you automatically.
You can make detail pages showing some or all of the fields in your export file, and you 
can make an index page that links to those detail pages. A new detail page is created for
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each record in your export file, and a new link to that detail page is created in your index 
file. 
If you have a lot of records you can have WebMerge make multiple index pages, with a 
subset of links to the detail pages on each according to criteria you specify in the Index 
Pages tab. You can learn more about index and detail template options in the sections 
Index Pages Tab and Detail Pages Tab respectively.
WebMerge tags offer a great deal of flexibility that can accommodate nearly any layout. 
For details on how to use WebMerge tags in your templates, see the section Using Tags in 
Templates.

Run WebMerge
Once you've assigned a source export file and set up your templates, the WebMerge 
window provides easy and flexible options for how and where those pages are generated. 
See 4W WebMerge Settings for details on these features. 
You can save these settings for future use, and even have them run automatically when 
you double-click the settings file. For more complex workflows you can have WebMerge 
run a series of settings files in succession for completely hands-free operation. See the 
section Generation Tab to learn more about these options.
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What's New in WebMerge 2.4?
WM-If tag has been extended to support multiple conditions, with AND and OR operators and 
nested parentheses to allow complex evaluations of data from multiple fields.
WM-Field tag now provides an option to use Unicode text in field data. 
The new WM-Wiki tag allows you very simple syntax in your database fields to describe web 
content.
The WM-ImagePath tag has been extended to allow standard image attributes which will be 
included in the generated code.
Generated pages can now have file names up to 255 characters on Windows and OS X.
Much of the program has been highly optimized, resulting in performance that's often more 
than twice as fast as previous versions.
All paths to directories and other settings are now stored as relative to the settings file, 
making it easy to move WebMerge-based solutions from one computer to another.
Improved appearances on all supported platforms, including native controls on Windows XP and 
Mac OS X.
Various minor bug fixes. All reproducible issues have been addressed for this release.

What's New in WebMerge 2.3?
WM-AccessLink tag builds links automatically from MS Access data fields of type Link.
New Replace attribute for the WM-Field tag lets you perform multiple search-and replace 
operations on field data before it's inserted into the page.
Debugger window lets you step through WebMerge's generation process to help diagnose 
errors in your templates.
TagMaker window lets you construct WebMerge tags with your field names quickly and easily 
with a point-and-click interface. Great for learning to write WebMerge tags, and fast enough 
to be valuable for experienced users. Tags can be easily copied for pasting into your favorite 
HTML authoring program.
Plug-In Tools architecture allows third parties to write custom utilities that run within 
WebMerge, and allows Fourth World to extend the product between releases. The Debugger 
and TagMaker tools use this new architecture.
A "Made with WebMerge" notice can be optionally added to the bottom of every generated 
page.
WebMerge now replaces spaces and other invalid characters in file names with a hyphen ("-"). 
Earlier versions of WebMerge had used an underscore ("_"). If you need your pages to be 
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generated using underscores as they were in earlier versions you can change this behavior at 
any time with the new File Name Hyphenator plug-in tool, available from the new Tools menu.
Various minor bug fixes. All reproducible issues have been addressed for this release.

What's New in WebMerge 2.2?
WM-Record tag now offers optional attributes to create multi-column index pages.
WM-FieldInclude tag lets you insert a text file or HTML file referenced by a path in your field 
data.
All navigation tags (WM-LinkNext, WM-LinkIndexNext, etc.) now allow attributes in the 
generated link, such as JavaScript function calls and CSS assignments.
A Favorites sub-menu has been added to the File menu for quick access to commonly-used 
settings files.
The FTP settings window now displays bullet characters ("•") in the password field.
A new "Preview in Browser" button has been added to the results window so you can quickly 
view the generated files in your browser.
The Test Mode option in the main window now offers a range of pages to generate. With that 
option on, you can choose to generate only 10, 20, 50, 100, 500, or 1000 pages.
In demo mode (no license key has been entered) WebMerge will write a notice at the bottom of 
the page that it was generated with an unlicensed version of WebMerge. Registered copied of 
WebMerge will not add any such info to your pages at all.
Various minor bug fixes. All reproducible issues have been addressed for this release.

What's New in WebMerge 2.1?
WM-IndexLabel tag lets you write a portion of an index page only when the value in the 
specified field changes between records. This is especially useful for labelling groups of 
records on the page.
WM-GenDate tag lets you insert the date your pages were generated, with a variety of 
formatting options.
WM-IndexRecordNumber tag gives you the position of a record on an index page.
WM-CurrentRangeStart tag tells you the beginning number of the range of records shown on 
an index page.
WM-CurrentRangeEnd tag gives you the ending number of the range of records shown on an 
index page.
The WM-Field tag now supports a new cgiEncoded attribute to format field data in a form 
suitable for submission to CGIs.
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Various bug fixes, mostly involving settings not being saved correctly. All reproducible issues 
have been addressed for this release.

What's New in WebMerge 2.0?
WebMerge 2.0 is a completely revised program offering a wide variety of valuable new features:

Conditional generation using IF-THEN tags in your templates.
The INCLUDE tag lets you merge any text or HTML document directly into your generated 
pages.
FIRST, NEXT, PREVIOUS, and LAST tags provided for easy linking to other detail or index pages.
WebMerge 2.0 can automatically create simple index and detail templates on the fly for instant 
publishing.
Multiple index pages, with automated pagination based on field changes or number of records. 
For example, you could have WebMerge create a new index whenever the first character of a 
field containing names changes, making alphabetically-categorized index pages.
You can include other WebMerge settings files to be executed when the current one finishes. 
This lets you chain sequences of generation activities for fully automated support of complex 
workflows.
Logging options let you maintain a listing of WebMerge results and tag interpretation errors so 
you can track down problems in your templates quickly.
Template pages can reside anywhere on your hard drive, with the folder you want WebMerge to 
generate its pages into specified separately.
If you need a different index or detail template for each record, just include the path to that 
file in a field in that database and WebMerge provides an option to let you use those to 
generate from.
WebMerge 2.0 can optionally upload generated pages to most Web servers via built-in FTP.
Any field delimiter can be used to parse your exported database or spreadsheet file. 
WebMerge provides quick selection for the most popular delimiters such as commas and tabs, 
but also provides space for you to enter your own if needed. Just about any file format with 
return-delimited records can be used.

Note for registered uses of WebMerge 1.9.3 or earlier: The registration keys for WebMerge have 
changed with version 2.0. Registered customers of any earlier version can obtain a key code for 
version 2.0 at no charge. To obtain your new key code, just send an email to 
webmerge@fourthworld.com, and be sure to include your name and your WebMerge 1.x key code.
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Quick Tutorial
Inside the WebMerge installation folder, you'll find a folder name Tutorial which contains the files 
you'll need to complete this exercise. While the file listing shown here is from Mac OS, the 
arrangement of the files are the same on both platforms.
This tutorial takes only a few minutes to complete, and will introduce you to the basics of using 
WebMerge.

What You'll Need
The files and folders needed for this tutorial are:

EvesDiaryExport.txt
A Merge-format file exported from a database
of fictional journal entries.
Web_pages (folder)
This is the target folder for the generated HTML
files.
DetailTemplate.html
This is inside the Templates folder, with 
placeholder tags for creating your detail pages.
IndexTemplate.html
This is inside the Templates folder, with 
placeholder tags for creating your index page.

Learning WebMerge in Nine Quick Steps
To run the example files through WebMerge:

Launch the WebMerge application1.

Click the button labeled "Exported File..." in the Sources tab, and select the file named 
"EvesDiaryExport.txt".

2.

Once you select the exported file, WebMerge will update the other controls in the Sources tab. 
The initial delimiter settings are derived from WebMerge's analysis of the data in the source 

3.
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file. In most cases WebMerge's defaults are just what you'll need, but it's always good to check. 
Since we know the format of the file and the program that exported it, we can ensure the 
delimiters are set correctly by selecting "FileMaker Pro: Merge" from the popup list at the right.

Click the Index Pages tab, and then click the checkbox labeled "Create Index Pages". This will 
trigger the "Folder..." button next to the checkbox, letting you select the folder you want the 
pages generated in. In the folder selection dialog, choose the folder to generate your index 
page in (Tutorial/Web_pages/).

4.

Still in the Index Pages tab, click the button labeled "Use one template file for Index pages". 
This will trigger the "File..." button next to it. In the file selection dialog that appears, select 
the file named "IndexTemplate.html" in the Tutorial/Templates folder. The defaults for the 
other controls on this page are fine for this tutorial.

5.

Click the Detail Pages tab, and the click the checkbox labeled "Create Detail Pages". This will 
trigger the "Folder..." button next to the checkbox, letting you select the folder you want the 
detail pages generated in. In the folder selection dialog, choose the folder to generate your 
detail pages in (Tutorial/Web_pages/entries/).

6.

Still in the Detail Pages tab, click the button labeled "Use one template file for Detail pages". 
This will trigger the "File..." button next to it. In the file selection dialog that appears, select 
the file named "DetailTemplate.html" in the Tutorial/Templates/ folder.

7.

Near the bottom of the Detail Pages tab, select the radio control named "Name based on 8.
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contents of field:", and in the popup control next to it select "ID" if it's not already selected. 
This tells WebMerge to name the new detail files based on the contents of the field named "ID" 
in each record of the source file. These files will be generated into the folder you specified in 
step 6.

Now you're ready to start generating pages. Just click the button labeled "Build Pages", and 
WebMerge will generate the files into the folders you specified. When it's done, WebMerge will 
present a dialog window reporting how many records were processed and how long it took.

9.

That's it! You've just learned the basics of using WebMerge. To learn more, see the topics in the 
Using WebMerge section of these Help pages, and check out the files included in the 
WebMerge_Examples folder.
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Learning More About WebMerge
WebMerge is easy to get started with, but also flexible enough to let you build some fairly complex 
sites. To learn more about how to get the most from WebMerge check out these resources on the
web:

WebMerge FAQ
As WebMerge's popularity grows, we're compiling a list of frequently-asked 
questions and updating it from time to time as needed.

WebMerge Discussion Forum
Trade tips and get advice from other WebMerge users in our user discussion 
forum.

Third-Party Tutorials
These tutorials were written by some of the most active contributors in our 
support forum, focusing on building multi-tier web sites using WebMerge:

Web-Procreate WebMerge Tutorial

Frank's WebMerge Tutorial
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Licensing 4W WebMerge
4W WebMerge can be used to generate up to 10 HTML pages from your database records. If you want 
to generate an unlimited number of pages you can obtain a license for only US $99.

How to Pay
You can register via credit card over the web using our online store at FourthWorld.com. The URL is:

http://www.fourthworld.com/products/webmerge/
Our storefront provides secure online transactions so your order will be handled conveniently and 
safely.

What Do You Get?
When you register 4W WebMerge, you get:

A registration code in your confirmation email.
Once you get that, simply launch WebMerge and select "Register" from the Help menu to open
the Registration tab of the Help window. When filling in the registration info, please remember 
to fill in all three fields (Name, Organization, and Registration Code) or the registration may 
not take effect.
Unlimited numbers of pages can be generated.
Prior to registering, WebMerge will generate only 10 pages from a given database file. Once
you've registered, the number of pages WebMerge can generate is limited only by available
memory.
Unlimited technical support for one year.
Please send any support inquiries to support@fourthworld.com. If you have an emergency (we 
recognize that sometimes getting data onto a Web site can be an emergency), feel free to use 
our toll-free number, 800-288-5825.
Free updates.
We add new features to WebMerge regularly. We take your suggestions seriously, act on them 
quickly, and release frequently. And we have a very liberal upgrade policy which gives you free 
updates for at least one year from purchase.

Note for registered uses of WebMerge 2.2 or earlier: The registration keys for WebMerge have 
changed with version 2.3. Paying customers of version 2.2 or earlier can obtain a key code for the 
current version at no charge. To obtain your new key code, just send an email to 
webmerge@fourthworld.com, and be sure to include your name and your old WebMerge key code.

Software License
The free demo version of 4W WebMerge may be distributed via Internet archives, web sites, online 
services such as America Online, user groups, BBSs, and informal transfers between friends. The free 
demo version of 4W WebMerge may be included in CD-ROM collections of freeware and shareware, 
and can be bundled with books or magazines, provided there is no charge incurred to the purchaser 
for 4W WebMerge itself, the Example files are included, and any data files generated by registered 
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users are not included. Under no circumstances may a registered copy of 4W WebMerge be 
distributed without explicit written consent of Fourth World Media Corporation.
USE THIS SOFTWARE AT YOUR OWN RISK. FOURTH WORLD MEDIA CORPORATION DISCLAIMS ALL 
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT, WITH RESPECT TO 
THE PROGRAMS AND THE ACCOMPANYING WRITTEN MATERIALS. ANY LIABILITIES INCURRED FROM THE 
USE OR MISUSE OF THIS PRODUCT WILL NOT EXCEED THE PURCHASE PRICE.
Customer may have other rights which vary from state to state.
©2000-2004 Fourth World Media Corporation. All rights reserved worldwide.
"Fourth World" is a registered trademark of Fourth World Media Corporation. 
All other trademarks are the property of their respective owners.
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Preparing your Source File
WebMerge can publish the data from any text file that contains data in a row-and-column format. 
The rows, or records, must be separated by return characters, and the columns, or fields, can be 
separated by any character, either quoted (",") or unquoted (,).
Nearly every database and spreadsheet program exports in a tab-delimited format, and some of 
those programs will include the names of the fields in the first line of the data. This is useful as it
makes placing your tags much easier, since you can use actual field names in your templates. If your
source file does not contain field names in the first line of its data, WebMerge will create field 
names for you based on the position of the field in the file (e.g., "Field_001", "Field_002", etc.).
If the program you're exporting from supports Merge format, that's the one you'll want to use. Merge 
includes field names and is ideally suited for this sort of task. FileMaker Pro, Microsoft Access, 
AppleWorks, and others support the Merge format (in Access this is listed in the Save As dialog as 
"Microsoft Word Merge").
You may need to consult the manual for your database or spreadsheet program for specifics, but 
most programs let you export by simply choosing File->Export, and then selecting the appropriate 
format from a list in the Save As dialog.
Some of the better database programs like FileMaker and Access provide rich scripting languages for 
you to automate the program's features. If you have a database file you'll be generating pages from
often, you can write scripts to automate your export, and include steps for sorting and filtering to 
arrange your data in any specific way you need.
Once you've exported your source file, you're reading to bring it into WebMerge. See the section on 
the Sources Tab for details on having WebMerge work with your source file.
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Preparing Your Templates
WebMerge uses templates to generate Web pages. A template is simply a standard HTML page with 
special placeholder tags. WebMerge replaces those tags with the corresponding data from your 
source file.
You can design your template pages using any HTML authoring program, including Macromedia 
Dreamweaver, Adobe GoLive, BBEdit, or even Word Pad.
If you need to generate pages instantly and don't need a customized layout, WebMerge also provides 
an option for generating simple templates automatically for you.
WebMerge can generate detail pages, or index pages, or both. A detail page uses data from a single 
record, with a new page generated for each record. An index pages shows data from multiple 
records on a single page.

Detail Templates
Here's a simple example of a template using the WM-Field tag to place the contents of a field into a 
page:

<html>
<body>
Hello world. My name is [WM-Field: UserName]
</body>
</html>

In this example, UserName is the name of a field in the database that was exported to the source 
file. If you had the value "Aram" as the data in that field, when WebMerge generates the page for 
that record the result would look like this:

 Hello World. My name is Aram.

When generating detail pages, WebMerge makes one copy of your detail template, and for each 
record in your source file it replicates a specified portion of your index template to provide a link to 
your detail page.

Index Templates
For index pages, WebMerge will replicate a portion of your template for each record in your source 
file. You specify the record portion of your index template using the WM-Record tag.
Any HTML between the [WM-Record] and [/WM-Record] tags will be replicated once for each record. 
The data within the WM-Record tags can contain other tags, such as WM-Field, so you can pretty 
much make any layout you want.
Here's an example of how it works. If your template contains this:

<body>
<table border="0" width="400">
[WM-Record]
<tr>
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<td>[WM-Field: Name]</td>
<td>[WM-Field: City]</td>
<td>[WM-Field: State]</td>
</tr>
[/WM-Record]
</table>
</body>

...then the HTML WebMerge generates will look something like this:
<body>
<table border="0" width="400">
<tr>
<td>Richard Gaskin</td>
<td>Los Angeles</td>
<td>CA</td></tr>
<tr><td>Joe Schmoe</td>
<td>Faketown</td>
<td>PA</td></tr>
<tr> <td>Jane Doe</td>
<td>Anytown</td>
<td>MO</td>
</tr>
</table>
</body>                         

If your index template contains WebMerge tags before the [WM-Record] tag or after the 
[/WM-Record] tag, WebMerge will still process those tags, using the data from the first record of 
your source file. If you're making multiple index pages, tags outside of the WM-Record tags are 
processed using the first record in the range for that page.

Field Names in Source Files
FileMaker and some other database tools modify multi-word field names when they generate Merge 
or other export file formats. For example, if your database contains a field named "First Name", in 
the exported Merge file it will be listed as "First_Name". When adding tags to your template HTML 
file, please keep this in mind and use underscores wherever spaces might otherwise appear in field 
names. So instead of writing your tag like this:

[WM-Field: First Name]

you should write:
[WM-Field: First_Name]

                                        

Learn More About WebMerge Tags

In addition to the WM-Field and WM-Record tags, WebMerge provides more than a dozen other tags, 
such the WM-Include tag which copies the contents of another HTML file into your page, and the 
WM-LinkIndex tag that automatically creates a link on a detail page to its corresponding index page. 
Some WebMerge tags also support optional attributes to determine how WebMerge will handle them.
See Using Tags in Templates for a list of all tags currently supported in WebMerge, with links to 
detailed notes on their usage.
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4W WebMerge Settings
WebMerge's settings are grouped into four categories:

Sources Select your source file, set field delimiter 
options, and optionally sort the records.

Index 
Pages

Select your index template and determine how 
generated index pages will be named.

Detail 
Pages

Select your detail template and determine how 
generated detail pages will be named.

Generation Select options for how your HTML is generated, 
and for automating WebMerge operations.

WebMerge settings can be saved to a file using File->Save, and opened with File->Open. 
Previously-saved files can be renamed to a new location using File->Save As.
See the section Generation Tab for tips on other options you can set for your WebMerge settings 
files.
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4W WebMerge Settings

Sources Tab
The Sources tab is where you tell WebMerge which exported data file to use and how that file is to 
be read.

Selecting a Source File
Once you've exported your source file (see Preparing Your Source File), you can load it into WebMerge
by clicking the "Exported File..." button. This presents your operating system's standard file selection
dialog to let you select any text file, and the name of the file you selected is displayed next to the
button.

Setting Delimiter Options
After you're selected a source file, the Import Options portion of the Sources tab becomes available.
This section lets you specify how the source file's fields are delimited (by tab characters, commas,
etc.).
When you first assign a source file, WebMerge examines the file and makes its best guess about
which delimiters are most appropriate. When the delimiters are set correctly, you'll see a list of field
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names on the left with a list of example data from the file on the right. If either of those displays are
shown on a single line, or have quotation marks around them, you can change the delimiters using
the combo box controls labeled "Delimiter" above each display.
WebMerge provides presets for most popular database and spreadsheet formats. Just choose the
program and format from the popup control labeled "Presets" and WebMerge will set the delimiters
for that file format. For example, if you've exported from Microsoft Access using the Microsoft Word
Merge format, just choose "MS Access: MS Word Merge" from the popup list. If you don't see your
program or format in the list, you can set the delimiters manually.

NOTE: If the file type you're using is shown in the Presets list, selecting that preset will
set the delimiters for that file type accurately. Adjusting delimiters for file types shown in
the Presets list other that what it sets may prevent WebMerge from parsing the file
correctly.

Each Delimiter combo box has a menu of the most common delimiters to choose from, both in quoted
(";") and unquoted (;) form. The tab character is not visible on screen, and is displayed as "<tab>". If
you need a delimiter not available in the Delimiter combo box you can type it directly into the
Delimiter display field.

Some file formats include the names of fields in the first line of the file. If your source file included
field names, set the "First line of file contains field names" checkbox and WebMerge will use those
names when looking for matching replacement tags. If your file does not include field names,
uncheck that box and WebMerge will create field names for you based on the order in which they
appear in the file (e.g., "Field_001", "Field_002", etc.).
Note that the field names in your replacement tags must be exactly as they appear in the list on the
left of WebMerge will not be able to make a match. If your original database file had any names
consisting of more than one word such as "First Name", most databases will export those with an
underscore replacing any spaces so the resulting field name would be "First_Name".
Many options in WebMerge let you specify a field by selecting it from a popup list. If you've assigned
a source file but the field names in that list appear in a single line, you'll need to adjust the
delimiters here to let WebMerge determine the field names correctly.
Microsoft Access and some other programs use delimiters inconsistently in some export files, with
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textual data enclosed in quotes, while numeric values are unquoted. If your file uses this convention,
just set the checkbox labeled "Text values are in quotes" to enable WebMerge to parse the file
properly.

NOTE: The "Text values are in quotes" option means ONLY text values are in quotes;
numeric and empty values are not quoted. That option exists to help the program
conform to Microsoft's specifications for CSV files, and while there are many other
inconsistencies with CSV files exported from different Microsoft products nearly all of
them identified as "commas-separate" or "CSV" use this quoting convention.
The advantage of not having to use "Text values are in quotes" (in addition to parsing the
file correctly <g>) is that you'll find WebMerge will run through it's "Setting up" phase
much faster without it. Accomodating Microsoft's CSV format is a very time-consuming
process, but files with a simpler format like tab-delimited or Merge get parsed by
WebMerge in one quick move.
If you see an odd character inserted in your pages where there should be an empty field,
what you're seeing is a character inserted as a placeholder during the lengthy and
complex process WebMerge must use to parse Microsoft CSV files. Turning off the "Text
values are in quotes" option will in most cases correct that issue.

Sorting Your Data
WebMerge lets you optionally sort your data before generating pages. This can be useful if you need
the contents of an index page to be in a particular order and are unable to sort the records in the
program from which the data was exported.
To sort your data first set the "Sort records by field" checkbox, and then select a field you want to
sort by. Sorting is done alphabetically according to the values in the selected field. You can choose
whether you want the sort to be in ascending order (small to large) or descending (large to small)
with the control on the right of that group.

Sorting is limited to data sets in which each record is 64k (65,535 characters) or less. That's about 14
pages of single-spaced copy, so chances are you'll never encounter this limit. If you do have an
export file with records larger than 64k, you can move the data from the largest fields into external
text files, replacing it with the path to the file in your records and use the WM-FieldInclude tag to
insert the data. If you must work with records larger than 64k, consider having your database
program perform the sort before exporting.

Why Sorting is Important

Sorting determines the order in which WebMerge processes records. This is especially important if
you're generating index pages and use the option to have WebMerge generate a new page when the 
value in a specified field changes (see the section on the Index Tab for details on those options).
When using that option it's important that you sort by the field you specify there, or you may end up 
with index pages that are incomplete. Here's why:
Suppose your records have data that looks like this:
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  1  California  Fresno
  2  California  Los Angeles
  3  Arizona     Phoenix
  4  Arizona     Tucson
  5  California  San Francisco

If you generate the pages without sorting, here's what WebMerge will do:
It creates an index page named "California", with an entry for "Fresno".1.
It appends the "California" index page with an entry for "Los Angeles".2.
"Arizona" is different from "California", so it closes the "California" page and creates a new 
index page named "Arizona", with an entry for "San Francisco".

3.
It apppends the "Arizona" page with an entry for "Tucson".4.
This record is another change, so it closes the "Arizona" page and creates a new page named 
"California", with an entry for "San Francisco".

5.

But because there is another "California" page, that page is overwritten with the new one. Hence, a
database that contains three records for "California" will appear to have only one, since the first two 
were overwritten.
Now, if you sort on the State field you get:
  1  Arizona     Phoenix
  2  Arizona     Tucson
  3  California  Fresno
  4  California  Los Angeles
  5  California  San Francisco

Here it's much simpler: It makes an index page for "Arizona" with an entry for "Phoenix", then it adds
"Tucson", then it closes the "Arizona" page and creates one for "California", adding entries for the 
three California cities before closing it.
So the trick is to just sort for the field you want to generate your index pages for and your index 
pages will have all the records you'd expect.
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4W WebMerge Settings

Index Pages Tab
The Index Pages tab lets you assign a folder for the pages to be generated into, assign a template 
for your index pages, and define how you want the generated index pages to be named.

Assigning a Destination Folder
If you want to generate index pages, check the box labeled "Create Index Pages in" to activate the 
features in the Index Pages tab. If you have not already assigned a folder in which to generate the 
pages, setting that checkbox will trigger to "Folder..." button next to it, which presents a dialog to let 
you select the target folder.

Assigning Templates for your Index Pages
WebMerge provides three ways to assign templates for your index page, which can be selected by 
clicking the appropriate radio control:
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Auto-Create New Template
WebMerge creates a simple index page template on the fly during generation, which contains a
single column showing the data from the field you specify with the popup list to the right of 
this control.
Use one template file for Index Pages
WebMerge will make your index page(s) from one template you prepare as an HTML document.
You can select your HTML index template using the "File..." button to the right of this option.
Use Template file specified in Field
If you need a different template file for each record, you can specify the path to that template 
in a field in your source file, and assign that field using the popup list to the right of this 
option. The path specified in field data can be either a full path, or relative to the destination 
folder.

Naming Generated Index Pages

WebMerge provides three options for determining the names of your generated index pages, with 
additional options for naming multiple index pages. The names of generated files consist of a base
name and an extension. Multiple pages may also use serial numbers to distinguish them.

You set the base name for your generated index pages in the field labeled "Base name", and the file 
extension is set in the field labeled "Extension". By default WebMerge uses "index" as the base name 
and ".html" as the extension, but you can change these as needed for your setup.
As you change options in these controls, WebMerge updates an example name in the upper right of 
this group showing you what the name of the first generated file will look like.
The three main options for naming index pages are:

Make only one Index page
If you want all entries shown on a single index page, use this option. Since only one index page
will be generated, its name is simply the base name appended with the extension.
Name based on contents of field
If you want to create multiple index pages, you can include a field in your database which 
contains the name of the index file you want that record shown in. You specify that field using
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the popup list to the right of this option.
WebMerge will use the first 255 characters of data in the specified naming field, so be sure you 
choose a field which is not likely to contain duplicated data across records. If the same data 
appears in your specified naming field in more than one record, each page generated with that 
name will overwrite any previously generated ones with the same name.
WebMerge alters data used as file names to be suitable for use on a Web server. Characters 
such as quotes, spaces, question marks, forward slashes, and others have special significance 
on a server, and such characters are converted to hyphen ("-") when the page is generated.The 
data in this field can also specify sub-folders for generated HTML pages.
Creating Subfolders
If the field you specify for the file name contains a standard UNIX folder name (separated by
"/") before the file name (e.g., "myfolder/filename") it will create the specified subfolder as it 
creates the file. These can even be several levels deep if you like, using something like this:
subfolder/anotherfolder/page001 
That data will generate a file named "page001.html" inside of a folder named "another folder",
inside of a folder named "subfolder".
Serialized names starting with #
If you want multiple index pages but do not have a field which defines their file names, 
WebMerge can create a series of index pages with serial numbers appended to them. You
assign the starting number for the series in the field to the right of this option.

When creating multiple index pages, WebMerge provides additional features to let you define when 
a new page will be created. Next to the label "Make new Index page when" is a popup list with these 
options:

value in this Field changes
WebMerge will create a new index page whenever the value in the field specified in the list at
the right of this option changes. This lets you group index page entries into categories. For
example, if you were using the US Congress source file provided in the WebMerge tutorial, you 
could create two index pages, once for each political party, by choosing this option and 
specifying the "Party" field.
first character in this Field changes
WebMerge will create a new index page whenever the first character in the field specified in
the list at the right of this option changes. This lets you group index page entries into more 
refined categories, and is especially useful for creating alphabetized groupings. For example, if 
you were using the US Congress source file provided in the WebMerge tutorial, you could create 
an index page for members of Congress whose name begins with the same letter by choosing 
this option and specifying the "Name" field.
first word in this Field changes
This is similar to the previous option but creates a new page only when the first work of the
data in the specified field changes.
a number of records is reached
WebMerge will create a new index page when a maximum number of records have been
written to the current index page. For example, if you want your index pages to list no more
than 50 entries on each page, just select this option and type "50" into the field that appears to 
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the right of it.

For details on creating your index templates, see the section Preparing Your Templates.
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4W WebMerge Settings

Detail Pages Tab
The Detail Pages tab lets you assign a folder for the pages to be generated into, assign a template 
for your detail pages, and define how you want the generated detail pages to be named.

Assigning a Destination Folder
If you want to generate detail pages, check the box labeled "Create Detail Pages in" to activate the 
features in the Detail Pages tab. If you have not already assigned a folder in which to generate the 
pages, setting that checkbox will trigger to "Folder..." button next to it, which presents a dialog to let 
you select the target folder.

Assigning Templates for your Detail Pages
WebMerge provides three ways to assign templates for your detail pages, which can be selected by 
clicking the appropriate radio control:
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Auto-Create New Template
WebMerge creates a simple detail page template on the fly during generation, which shows
each field name with the corresponding field data next to it.
Use one template file for Detail Pages
WebMerge will make your detail pages from one template you prepare as an HTML document.
You select your HTML detail template using the "File..." button to the right of this option.
Use Template file specified in Field
If you need a different template file for each record, you can specify the path to that template
in a field in your source file, and assign that field using the popup list to the right of this 
option. The path specified in field data can be either a full path, or relative to the destination 
folder.

Naming Generated Detail Pages

WebMerge provides two options for determining the names of your generated detail page. The 
names of generated files consist of a base name and an extension, and can either be based on the 
contents of a field or serialized.

You set the base name for your generated detail pages in the field labeled "Base name", and the file 
extension is set in the field labeled "Extension". By default WebMerge uses "record" as the base 
name and ".html" as the extension, but you can change these as needed for your setup.
As you change options in these controls, WebMerge updates an example name in the upper right of 
this group showing you what the name of the first generated file will look like.
The three main options for naming index pages are:

Name based on contents of field
You can include a field in your database which contains the name of the detail file you want 
that record generated to. You specify that field using the popup list to the right of this option.
WebMerge will use the first 255 characters of data in the specified naming field, so be sure you 
choose a field which is not likely to contain duplicated data across records. If the same data 
appears in your specific naming field in more than one record, each page generated with that 



file:///Area%2051/4W/WebMerge/wm24/dev/4W%20...

29 of 91 2/10/05 2:23 PM

name will overwrite any previously generated ones with the same name.
WebMerge alters data used as file names to be suitable for use on a Web server. Characters
such as quotes, spaces, question marks, forward slashes, and others have special significance 
on a server, and such characters are converted to hyphen ("-") when the page is generated.The 
data in this field can also specify sub-folders for generated HTML pages.
The data in this field can also specify sub-folders for generated HTML pages. If the field you
specify for the file name contains a standard UNIX folder name (separated by "/") before the 
file name (e.g., "myfolder/filename") it will create the specified subfolder as it creates the file. 
These can even be several levels deep if you like, using something like this:
subfolder/anotherfolder/page001
That data will generate a file named "page001.html" inside of a folder named "another folder",
inside of a folder named "subfolder".
Serialized names starting with #
If you do not have a field which defines their file names, WebMerge can create detail pages 
with serial numbers appended to them. You assign the starting number for the series in the 
field to the right of this option.

For details on creating your detail templates, see the section Preparing Your Templates.
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4W WebMerge Settings

Generation Tab
The Generation tab provides additional options for governing how WebMerge generates your pages, 
and any post-processing you'd like it to do, such as uploading the files to your server or running 
additional settings files.

Auto-Run Option
One of the most powerful features of WebMerge is its ability to let you save your settings to a file 
and have them run automatically when that file is double-clicked. To activate this feature, first save 
your settings by choosing File->Save, and then set this checkbox:

If you want to modify a settings file after it's been saved with this option, first open WebMerge and 
then choose File->Open to select the file. The auto-run feature is only activated when a settings file
is opened by double-clicking it in the OS.

Write URLs as Links
WebMerge can automatically generate URLs in your data as active HTML links. Just click the 
checkbox labeled "Write URLs as links", and any field which contains a valid URL (e.g., 
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"http://www.fourthworld.com") will be written using an href tag.
The following services are recognized anywhere in the field data when this option is set: mailto, ftp, 
news, and of course http. When using the mailto service, the service name ("mailto:") is not included 
in the link's display text; all other services are displayed as complete URLs. Email addresses do not 
require the "mailto:" service specifier; WebMerge should be able to identify any properly-formatted 
email address when this option is active.

For example, if your source data contained this:
   Go to our Web site:  http://www.fourthworld.com

It would be generated like this:
   Go to our Web site: <a href="http://www.fourthworld.com">http://www.fourthworld.com</a>

Prepend Image Paths
This option allows special handling of image paths. Sometimes you may not know the path to your 
images folder at the time you enter the data in your database. If you had included the path (e.g., 
"project/images/") and it changed to, say, "project/myproject/images/", you would have to modify 
every record in your database to match the new directory structure. We think that's too much work.
WebMerge makes handling cases like this a snap. In your database, simply enter the short name of 
the image file only, without any of the path information (e.g., "mypicture.jpg"). After you export your 
data and open WebMerge, you can turn on the option labeled "Prepend Image Path to....", and select 
the field with the file name you want the path added to.

For example, suppose we had a folder named "images" containing our JPEGs, and in our database we 
store only the short names of each image (e.g., "Cake.jpg"). In WebMerge, we turn on the prepend 
option for image paths, select the field named "Food_Image" from the popup menu provided, and in 
the field below it we type the path:

images/

When WebMerge generates the pages, it will replace the source URL portion of your IMG tag with not 
only the short file name you had in your data, but will also include the path you specified:

<IMG SRC="images/Cake.jpg">

You probably won't need to use this option often, but when you do you'll find it invaluable.

FTP Files to Server
Once WebMerge has finished generating your pages, you can have it upload those pages to your 
server by setting this checkbox:
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The popup list to the right lets you select from the FTP servers you've entered. You can enter new
server info or modify an existing set of info by choose "Edit list..." from this control. This opens the
FTP Server Settings window which lets you create or delete FTP settings. Each FTP setting consists of
a label (which appears in the popup list in the Generation tab), the host address or name (e.g., 
"ftp.fourthworld.com), your user name and password for that host, and you can optionally specify the 
directory on that server that is the root of your Web site.
On the right of this section is a button labeled "Root Folder", which lets you select a folder on your 
hard drive which acts as the root of your site. This lets WebMerge determine the relative location of 
files as they should be uploaded to your server. For example, if you generated a file at 
"/HardDrive/site/pages/index.htm", and your root folder is "/HardDrive/site/", WebMerge will log 
into your server and copy the file to the directory "/pages/". If no such directory exists on your 
server, WebMerge will create it for you.
For expediency, WebMerge will only upload the files it generates. If you need to upload other files
related to your site, consider using a dedicated FTP program.

Don't Show Results Dialog
By default, when WebMerge has finished generating pages it presents a summary of results in a 
dialog window. You can turn this option off by setting this checkbox:

Note that this option is set automatically when you set the Auto-Quit option (see below). If it is
unchecked with Auto-Quit set, WebMerge will not be able to quit while it waits for you to dismiss 
the results dialog manually.

Logging Results
WebMerge can optionally log results and errors to a log file for your reference by setting this 
checkbox:

If you have not already specified a log file, setting this option will trigger the "File..." button to let 
you specify where the results log will be written. You can also choose whether you want WebMerge
to retain previous logs by appending the log file by choosing the "Append" option, or overwrite older 
logs by choosing "Overwrite".

Run Other WebMerge Files
WebMerge lets you run batches of settings files by adding those files to this list and setting this 
checkbox:
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You can select other WebMerge settings files to add to this list by clicking the "Add Settings File.." 
button. To remove a file from this list, first select it and click "Remove File from Queue".
You can change the order in which these files are processed by using the "Move Up" and "Move 
Down" buttons on the right.
Note that any settings files included in this list must have their Auto-Run and Don't Show Results 
options set in order to avoid interrupting your batch run.

Auto-Quit
You can have WebMerge automatically quit after it finishes generating your pages by setting this 
option:

This is especially useful when used in conjunction with the Auto-Run option, so you can have 
WebMerge launch, process your files, and quit in one move.

Include "Made with WebMerge"
You can have WebMerge insert a notice stating "Thispage was made with 4W WebMerge" at the 
bottom of every generated page by setting this option. The notice contains a link to the WebMerge
product page at fourthworld.com. When this option is set, WebMerge will also insert a "generator" 
meta tag into the head of each page.
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Automating WebMerge with Settings Files
WebMerge lets you save your settings to a file, and provides additional options for automating how 
WebMerge runs.
You can save your current WebMerge settings by choosing "Save Settings File" from the File menu. 
Saved settings files can be opened with the "Open Settings File" menu item. You can clear your 
current WebMerge settings with the "New Settings File" menu item.
The obvious advantage of saving your settings to a file is to save time next time you have to 
generate pages from the same source and templates.
But the real power of working with settings files is that they let you completely automate WebMerge: 
with the appropriate options selected in the Generation tab you can have WebMerge launch, 
generate your pages, upload them to your server, and quit, all by just double-clicking your settings 
file icon.
The automation options are described in detail in the Generation tab section, but they're worth 
calling your attention to them here to better understand how they can work together to streamline 
your workflow.

Setting the Auto-Run Options
The first step to automating WebMerge is to set this option in the Generation tab:

When checked, double-clicking a WebMerge settings file icon not only loads the settings but also 
runs WebMerge, generating pages from the templates and source file specified in the file.
This is not limited to double-clicking. Any normal means of launching an application with a given 
document on your operating system will work, including using VBS or batch files (Windows) or with 
AppleScript (Mac OS). This means that you can have other applications (such as your database 
program if it supports it) trigger WebMerge to run. 
For example, you could create a script in FileMaker Pro that could sort and filter records, export 
them to a specified file, and run WebMerge to generate pages from that export file. Using your 
database's scripting in conjunction with WebMerge's Auto-Run option, you can automate most of 
your production workflow.
If you need to change any of the options in a settings file that has this option checked, just launch 
WebMerge first and then open the document by choosing "Open Settings File" from the File menu.
Any WebMerge settings files opened from within the program this way will load the settings but will 
not run them until you click the "Build Pages" button.

Of course, if you launch an Auto-Run settings file, you may want WebMerge to quit when its done to 
free up system resources. To have WebMerge quit when it's done processing an automated settings 
file, just set this option:
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By default, WebMerge displays a dialog window when its done building pages that shows the number 
of pages generated and the elapsed time. If you're automating WebMerge you probably don't want
that dialog shown, since it requires you to click its OK button to dismiss it. You can prevent that
dialog from appearing with this option:

Run Other WebMerge Files
WebMerge lets you run batches of settings files by adding those files to this list and setting this 
checkbox:

You can select other WebMerge settings files to add to this list by clicking the "Add Settings File.." 
button. To remove a file from this list, first select it and click "Remove File from Queue".
You can change the order in which these files are processed by using the "Move Up" and "Move 
Down" buttons on the right.
Note that any settings files included in this list must have their Auto-Run and Don't Show Results 
options set in order to avoid interrupting your batch run.

FTP Files to Server
Once WebMerge has finished generating your pages, you can have it upload those pages to your 
server by setting this checkbox:

The popup list to the right lets you select from the FTP servers you've entered. You can enter new 
server info or modify an existing set of info by choose "Edit list..." from this control. This opens the 
FTP Server Settings window which lets you create or delete FTP settings. Each FTP setting consists of 
a label (which appears in the popup list in the Generation tab), the host address or name (e.g., 
"ftp.fourthworld.com), your user name and password for that host, and you can optionally specify the 
directory on that server that is the root of your Web site.
For expediency, WebMerge will only upload the files it generates. If you need to upload other files 
related to your site, consider using a dedicated FTP program.

Logging Results
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WebMerge can optionally log results and errors to a log file for your reference by setting this 
checkbox:

If you have not already specified a log file, setting this option will trigger the "File..." button to let 
you specify where the results log will be written. You can also choose whether you want WebMerge 
to retain previous logs by appending the log file by choosing the "Append" option, or overwrite older 
logs by choosing "Overwrite".

Moving Settings Files To Other Computers
The file paths in WebMerge settings files are stored relative to the location of the settings file itself.
This means that if you keep your WebMerge settings files in the same folder as your other 
Web-related files, you can move the folder that contains all of them to another location on your 
computer, or even another computer, and the settings file will still be able to locate the source files 
you've specified.
The file format of WebMerge settings files is the same for both Windows and Mac OS. So if you're
working as part of a team with others with their own licensed copy of WebMerge, you can move files 
from machine to machine, even across platforms.
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Automating WebMerge with Apple Events
While the Settings File options will satisfy most automation needs, there may be times when you 
want to be able to set the values of some WebMerge settings on the fly. If you use Mac OS, you're in 
luck: WebMerge supports the "do script" Apple event, so you can use AppleScript or even raw Apple 
events to control WebMerge.
A complete description of how to use AppleScript and Apple events is beyond the scope of this 
discussion, but if you're familiar with the basics you'll have a good time here.
WebMerge supports the "do script" ('dosc') and "evaluate" ('eval') Apple events, which provide general 
hooks into WebMerge's inner workings. Below is a description of each of these events, and the 
internal commands you can call using them:

The "Do Script" Event
The "do script" Apple event lets you execute internal commands in WebMerge. Please keep in mind 
that, unlike using AppleScript, all of the arguments you send to a WebMerge command must be of 
type TEXT (as opposed to file alias, list, or other types sometimes supported in AppleScriptable 
applications).
The general syntax for the "do script" event is:

<command> "<param>"

where <command> is the name of a WebMerge command, and "<param>" is an argument passed to 
the command. Arguments are always passed in quotes. Not all of the WebMerge commands require 
arguments; some require only the command name.
For consistency, all "do script" commands begin with "Set" (e.g., "SetExportFile").

The "Evaluate" Event
The "evaluate" Apple event requests specific information from WebMerge, and returns the requested 
information as its result. In FileMaker Pro, you have the option of having Apple event results copied 
to the clipboard, which can then be pasted into a field or used in a calculation.
The general syntax for the "evaluate" event is:

<command>()

Note that all of WebMerge's commands which return a value require parentheses after them. None of 
them require any arguments to be passed to them.
For consistency, all "evaluate" functions begin with "Get" (e.g., "GetExportFile").

Syntax Guide
Below are the commands and functions available in WebMerge 2.1, grouped by the corresponding tab 
in the WebMerge window:

Sources Tab
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SetExportFile "<completeFileName>"
where <completeFileName> is the full path to the exported Merge database file (e.g., 
"/HD/Folder/Filename").
GetExportFile()
returns the full path to the exported Merge database currently set in WebMerge.

SetSourceFormatPreset "<presetLabel>"
where <presetLabel> is a string that matches one of WebMerge's built-in presets.
GetSourceFormatPreset()
returns the label of the currectly chosen delimiter preset.

SetFirstLineIsFieldNames "<Boolean>"
where <Boolean> is either "true" or "false", determining whether or not the first line of 
the source data shoude be treated as field names.
GetFirstLineIsFieldNames()
returns "true" if this option is set, and false if not.

SetNameDelimiter "<delimiter>"
where <delimiter> is any character or string of characters used to delimit the first line of 
the source file, provided the first line is used as field names.
GetNameDelimiter()
returns the chracter or string of characters used to delimit the fields in the first record of
the source file.

SetDataDelimiter "<delimiter>"
where <delimiter> is any character or string of characters used to delimit the data in the 
source file.
GetDataDelimiter()
returns the chracter or string of characters used to delimit the fields in the source file.

SetOnlyTextValuesHaveQuotes "<Boolean>"
where <Boolean> is "true" is "true" or "false", determining whether the source file uses
quotes around textual values.
GetOnlyTextValuesHaveQuotes()
returns "true" or "false", depending on the current setting for that opion.

SetSortRecords "<Boolean>"
where <Boolean> is either "true" or "false", determining whether the records in the
source file are to be sorted before being used to generate pages
GetSortRecords()
returns "true" or "false", depending on the current setting for that opion.

SetSortRecordsField "<fieldName>"
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where <fieldName> is the name of the field whose values are sorted prior to generation, 
provided the SetSortRecords has been set to "true".
GetSortRecordsField()
returns the name of the field currecly assigned to be sorted prior to generation.

SetSortRecordsOrder "<sortOrder>"
where <sortOrder> is either "ascending" or "descending", determinging the order in 
which values are compared in the field specified to be sorted.
GetSortRecordsOrder()
returns either "ascending" or "descending", according to the current setting for that
option. 

Index Pages Tab
SetBuildIndexPages "<Boolean>"
where <Boolean> is either "true" or "false", determinig whether to generate index pages.
GetBuildIndexPages()
returns "true" or "false", depending on the current setting for that opion.

SetIndexTargetFolder "<completeFolderPath>"
where <completeFolderPath> is the full path to the folder in which WebMerge will 
generate index pages.
GetIndexTargetFolder()
returns the full path to the folder in which WebMerge wil generate index pages.

SetIndexTemplateMode "<modeSpecifier>"
where <modeSpecifier> is either "new" (to have WebMerge auto-create a template on 
the fly), "file" (use an HTML template), or "field" (using a field in your database to specify 
a path to a template file, letting you use a different template for each file).
GetIndexTemplateMode()
returns the mode specifier currently in use, as described above. 

SetIndexAutoCreateField "<fieldName>"
where <fieldName> is the name of a field whose vales will be shown on an index page 
auto-created by WebMerge.
GetIndexAutoCreateField()
returns the name of the field currently assigned for this option.

SetIndexTemplateFile "<filePath>"
where <filePath> is the full path to the teplate page to be used when the 
IndexTemplateMode is set to "file". 
GetIndexTemplateFile
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returns the path to the file assigned to this option.

SetIndexTemplateField "<fieldName>"
where <fieldName> is the name of a field containing the path to a template file when 
the Index Template Mode is set to "field".
GetIndexTemplateField()
returns the name of the field set for this option.

SetIndexFileNameMode "<modeSpecifier>"
where <modeSpecifier> is either "single" (generate one index page for all records), 
"field" (use the contents of a field to specify the index file name), or "serial" (create 
unique serialized names for each index file created).
GetIndexFileNameMode()
returns the value set for this option.

SetIndexFileBaseName "<name>"
where <name> is the base name WebMerge uses to create serialized file names for 
generated index pages.
GetIndexFileBaseName()
returns the current index file base name.

SetIndexFileNameStartNum <number>
where <number> is an integer used as the starting number for serialized index file 
names.
GetIndexFileNameStartNum()
returns the current starting number for serialized index file names.

SetIndexFileNameField "<fieldName>"
where <fieldName> is the name of a field whose value is used to determine the names 
of generated index pages when the File Name Mode is set to "field".
GetIndexFileNameField()
returns the value set for this option.

SetIndexFileNameExtension "<extension>"
where <extension> is a string appended the generated index files to specify their type
(commonly "html").
GetIndexFileNameExtension()
returns the current file type extension for index pages.

SetIndexCreateNewPageMode "<modeSpecifier>"
where <modeSpecifier> is one of the following, which correspond to the choices in the 
popup control: "value in this Field changes:", "first char in this Field changes:", "first word 
in this Field changes:", or "a number of records is reached:".
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GetIndexCreateNewPageMode()
returns the value set for this option.

SetIndexCreateNewPageField "<fieldName>"
where <fieldName> is the name of a field used for comparison according to the criteria 
mentioned in the IndexCreateNewPageMode option.
GetIndexCreateNewPageField()
returns the value set for this option.

SetIndexCreateNewMax <number>
where <number> is the maximum number of records to be written to a given index page 
before generating a new one, if the IndexCreateNewPageMode is set to "a number of 
records is reached:".
GetIndexCreateNewMax
returns the value set for this option.

Detail Pages Tab

SetBuildDetailPages "<Boolean>"
where <Boolean> is either "true" or "false", determinig whether to generate detail 
pages.
GetBuildDetailPages()
returns "true" or "false", depending on the current setting for that opion.

SetDetailTargetFolder "<completeFolderPath>"
where <completeFolderPath> is the full path to the folder in which WebMerge will 
generate detail pages.
GetDetailTargetFolder()
returns the full path to the folder in which WebMerge wil generate detail pages.

SetDetailTemplateMode "<modeSpecifier>"
where <modeSpecifier> is either "new" (to have WebMerge auto-create a template on 
the fly), "file" (use an HTML template), or "field" (using a field in your database to specify 
a path to a template file, letting you use a different template for each file).
GetDetailTemplateMode()
returns the mode specifier currently in use, as described above.

SetDetailTemplateFile "<filePath>"
where <filePath> is the full path to the teplate page to be used when the 
DetailTemplateMode is set to "file".
GetDetailTemplateFile
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returns the path to the file assigned to this option.

SetDetailTemplateField "<fieldName>"
where <fieldName> is the name of a field containing the path to a template file when 
the Detail Template Mode is set to "field".
GetDetailTemplateField()
returns the name of the field set for this option.

SetDetailFileNameMode "<modeSpecifier>"
where <modeSpecifier> is either "field" (use the contents of a field to specify the detail 
file name), or "serial" (create unique serialized names for each detail file created).
GetDetailFileNameMode()
returns the value set for this option.

SetDetailFileBaseName "<name>"
where <name> is the base name WebMerge uses to create serialized file names for 
generated detail pages.
GetDetailFileBaseName()
returns the current detail file base name.

SetDetailFileNameStartNum <number>
where <number> is an integer used as the starting number for serialized detail file 
names.
GetDetailFileNameStartNum()
returns the current starting number for serialized detail file names.

SetDetailFileNameField "<fieldName>"
where <fieldName> is the name of a field whose value is used to determine the names 
of generated detail pages when the File Name Mode is set to "field".
GetDetailFileNameField()
returns the value set for this option.

SetDetailFileNameExtension "<extension>"
where <extension> is a string appended the generated detail files to specify their type
(commonly "html").
GetDetailFileNameExtension()
returns the current file type extension for index pages.

Generation Tab
SetAutoRun "<Boolean>"
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where <Boolean> is either "true" or "false", determinig whether the auot-run feature o 
enabled for the current settings file.
GetAutoRun()
Returns "true" if the "Have WebMerge start building page when this settings file loads"
option is set in the Settings File Options dialog, or "false" if not.

SetPrependImagePath "<Boolean>"
where <Boolean> is either "true" or "false", determinig whether the Prepend Image Path 
feature is enabled.
GetPrependImagePath()
returns "true" if this option is set, and false if not.

SetImagePath "<relativeFolderPath>"
where <completeFolderPath> is the relative path to a folder which contains images to be 
used by the generated HTML file (e.g., "../images/").
GetImagePath()
If the "Prepend Image Path" control is currently checked in WebMerge, this command
returns the value in the field below that checkbox control. If the "Prepend Image Path" 
control is not currently checked, this command returns "false".

SetPrependImagePathField "<fieldName>"
where <fieldName> is the name of the field in the current exported Merge database file 
which will be used for images in any image links which may be in the template file.
GetPrependImagePathField()
Returns the name of the field in the current exported Merge database file which is to be
prepended with the contents returned by GetImagePath(). If the checkbox associated with 
this option is not set, an empty string is returned.

SetWriteURLsAsLinks "<Boolean>"
where <Boolean> is "true" if you want to set the option labeled "Write URLs as links", or 
"false" if you do not want this behavior.
GetWriteURLsAsLinks()
Returns "true" if the option labeled "Write URLs as links" is set, and "false" if not.

SetRunMoreSettings "<Boolean>"
where <Boolean> is either "true" or "false", determinig whether other queued WebMerge 
files will be executed when the current one is done.
GetRunMoreSettings()
returns "true" if this option is set, and false if not.

SetSettingsQueue <fileList>
where <fileList> is a return-delimited list of the complete paths to other WebMerge 
settings files.
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GetSettingsQueue()
returns the current list of queued settings files.

SetUploadPages "<Boolean>"
where <Boolean> is either "true" or "false", determinig whether
GetUploadPages()
returns "true" if this option is set, or "false" if not.

SetFTPServer <ftpSetName>
where <ftpSetName> is the name of the FTP settings to be used when uploading files.
GetFtpServer()
returns the name of the FTP settings currently in use.

SetRootFolder <folderPath>
where <folderPath> is the full path to a local folder that contains your Web site.
GetRootFolder()
returns the path to the local folder that contains your Web site.

SetDontShowResults "<Boolean>"
where <Boolean> is either "true" or "false", determining if the results dialog that 
normally appears at the end of a WebMerge run will be supressed.
GetDontShowResults()
returns "true" if this option is set, and false if not.

SetDontShowResults "<Boolean>"
where <Boolean> is either the string "true" or "false", which determines whether
WebMerge will show its results dialog after it's done generating Web pages. If you want 
to have WebMerge quit when it's done, it's a good idea to set this value to true.
GetDontShowResults()
Returns "true" if the "Don't show results dialog after building pages" option is set in the
Settings File Options dialog, or "false" if not.

SetAutoQuit "<Boolean>"
where <Boolean> is either the string "true" or "false", which determines whether 
WebMerge will automatically quit after it's done generating files.
GetAutoQuit()
Returns "true" if the "Have WebMerge quit after building pages" option is set in the
Settings File Options dialog, or "false" if not.

SetLogResult"<Boolean>"
where <Boolean> is either the string "true" or "false, determining whether logging is
enabled."
GetLogResults()
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returns "true" if this option is set, and false if not.
on SetLogFile <filePath>
where <filePath> is the complete path to the text file to log file.
GetLogFile()
returns the full path to the log file.

SetLogWriteMode <modeSpecifier>
where <modeSpecifier> is either "append" or "overwrite", determining how the log file 
will be written.

GetLogWriteMode()
returns the current log mode.

General
BuildPages
No arguments are passed with this one. It simply tells WebMerge to start generating files
based on the current settings.
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Troubleshooting
It may be possible to have data in your database, or perhaps even names of fields in your database, 
which may cause unexpected behavior in WebMerge. We tested WebMerge on a variety of data files 
with a good many different system configurations. Just the same, some people have weird data, 
sometimes too weird for us to have anticipated.
We know of one case which is not likely to occur, but in the interest of completeness we'll include it 
here:
If you have data in a field in your database which contains quote-comma-quote, WebMerge may get 
confused about where data from one field ends and the next begins. This pattern shouldn't occur 
normally, so you'll probably never encounter it unless there's something odd with your data to begin 
with. This isn't likely to occur in the real world, but there's the caveat just the same.
Aside from this one possible anomaly, we have not come across any other files generated by popular 
database systems in Merge format which WebMerge couldn't handle. If you do, please let us know.
Should you come across an example of an exported Merge file that does not work as expected with 
WebMerge, please send it to us in an email with your template HTML file and a description of the 
problem. We can't guarantee a fix for all cases, but we'll certainly do our best to issue updates for 
those we can.
Please send all support inquiries to support@fourthworld.com. In most cases it's very helpful if you 
attach your source file and templates, to help us reproduce the problem here. Issues that can be
reproduced in our office can usually be resolved very quickly.
We look forward to providing you with the highest quality tools we can.
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4W WebMerge Tags
WebMerge supports the following tags:

Data Insertion Tags
WM-Field Inserts the contents of a field
WM-ImagePath Inserts an image path
WM-Include Inserts an external HTML page

WM-FieldInclude Inserts an external HTML page specified 
in field data

WM-Record Defines the record portion of an index 
page

WM-AccessLink Processes link fields from Microsoft 
Access

WM-Wiki Processes simple Wiki code in a field
Conditional Tags

WM-If Conditional generation of portions of a 
page

WM-IndexLabel Conditionally inserts field data on an 
index page

Navigation Tags

WM-LinkFirst Link from a detail page to the first detail 
page

WM-LinkPrevious Link from a detail page to the previous 
detail page

WM-LinkNext Link from a detail page to the next detail 
page

WM-LinkLast Link from a detail page to the last detail 
page

WM-LinkIndex Link from a detail page to an index page

WM-LinkIndexFirst Link from an index page to the first index 
page

WM-LinkIndexPrevious Link from an index page to the previous 
index page

WM-LinkIndexNext Link from an index page to the next index 
page

WM-LinkIndexLast Link from an index page to the last index 
page

WebMerge Info
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WM-CurrentRecordCount The number of records in the source file

WM-CurrentRecordNumber The number of the current record being 
processed

WM-IndexRecordNumber The number of the current record on an 
index page

WM-CurrentRangeStart The start of the range of records on an 
index page

WM-CurrentRangeEnd The start of the range of records on an 
index page

WM-GenDate The date the pages were generated

Note about tag prefixes for users of WebMerge 1.x:
Earlier versions of WebMerge used the prefix "FMP" for tags instead of "WM", to illustrate the 
similarities between WebMerge tags and those used in FileMaker Pro, a popular cross-platform 
database. In WebMerge 2.0 and later, the prefix was changed to "WM" to avoid confusion in those 
cases where the WebMerge implementation may vary from that of a similar tag in FileMaker Pro. 
Given that WebMerge generates static Web pages and FileMaker Pro creates them dynamically from 
the server, such differences are inevitable.
WebMerge 2.0 and later supports both prefix forms, but you are encouraged to use the "WM" form 
shown here for any new templates you create, as we anticipate deprecating support for the "FMP" 
form in a future release.
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4W WebMerge Tag Reference

WM-Field
Syntax [WM-Field: fieldName]

[WM-Field: fieldName raw]

[WM-Field: fieldName nolink]

[WM-Field: fieldName Unicode:language]

[WM-Field: fieldName cgiEncoded] 

[WM-Field: fieldName replace(findString,replaceStr] 

Example Name: [WM-Field: First_Name]<br />
Tel: [WM-Field: Phone]<br />
Description: [WM-Field: JobDescription raw replace("/","-")]

Description The [WM-Field] tag is replaced by the contents of the field specified in fieldName.
Using the raw attribute
By default, WebMerge converts field data to HTML. The conversion changes all 
non-ASCII characters to their corresponding character entity according to the ISO 
8859-1 standard. For example, the character "<" becomes "&lt;". This attribute is 
useful if your database contains some fields whose data is already in HTML format, 
to prevent WebMerge from altering it for Web display. If your field already contains 
HTML, you can tell WebMerge not to perform this conversion by using the raw
attribute.

Using the nolink attribute
When used in an index template, by default WebMerge generates all WM-Field
tags as links to the corresponding detail page. The optional nolink attribute is 
used in index pages to tell WebMerge to write the tag without linking it to that 
detail page. If used in a detail page template, the nolink attribute is ignored.

Using the Unicode attribute
By default, WebMerge assumes that any field data contains 8-bit characters, as is
common for English and many other Western languages. But if you database 
includes fields that use Unicode text (16-bit text used for Japanese, Chinese, and 
others) you can tell WebMerge to treat the text as Unicode by including the 
Unicode attribute.
When specifying Unicode, you must also specify a language, which can be any of 
the following:



file:///Area%2051/4W/WebMerge/wm24/dev/4W%20...

50 of 91 2/10/05 2:23 PM

Arabic Greek Roman Ukrainian
Bulgarian Hebrew Russian (Cyrillic) Unicode 

(UTF-16)
Chinese Japanese 

(Shift-JIS) Russian
English Korean SimpleChinese

For example, using this in a template:
 [WM-Field: MyJapaneseData Unicode:Japanese] 

...will generate the text using the Unicode characters for Japanese. 

Using the cgiEncoded attribute
This attribute tells WebMerge to encode the data from the specified field in a
format appropriate for sending to a CGI. All spaces are replaced with "+" 
characters, and all special characters are converted to hex encodings of the form 
%XX.
For example, if we wanted to send field data to the Google search CGI we could 
include something like this in our template:
  <a href="http://www.google.com/search?q=
   [WM-Field: MyField cgiEncoded]">Click here</a>

If your field data contained "Fourth World" the generated HTML would be:
  <a href="http://www.google.com/search?q=fourth+world">
   Click here</a>

Since the cgiEncoded attribute controls formatting in links, it cannot be used in 
conjunction with the raw or nolink attributes.

Using the replace attribute

The replace attribute is a function that tells WebMerge to replace any instances of 
the string in findString with the value in replaceString for the specified field.
Each findString and replaceString can be any string of characters contained within 
quotation marks and separated by commas. You can include quote and comma 
characters by using the contants "quote" and "comma", respectively, concatenating 
with the "&" character as needed.
For example, if your fied data contained:
  He said Hello World

...then this:
 [WM-Field: MyField replace("Hello World", quote&"Hello"&comma&" World!"&quote)]

...would generate this HTML:
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 He said &quot;Hello, World!&quot;

You can have any number of comma-separated find-and replace pairs between 
the parentheses, each pair separated by semi-colons:
 [WM-Field: MyField replace("find","replace";"/","-")]

Other link attributes
HTML supports a variety of attributes for links, such as specifying a target frame in 
which to open linked pages. In addition to the WebMerge attributes noted above, 
you can also include any number of standard link attributes in your index 
templates, and these will simply be copied into the generated link code. Just 
include any attributes you want included in your link after any WebMerge 
attributes.
For example, if your template reads:

[WM-Field: FieldName target="Frame"]

Then the resulting link will read:
<a href="detail.html" target="Frame">FieldData</a>
Note about file names
Remember that if your original field name has spaces in it, most databases will 
replace spaced with underscores, which is the form WebMerge will expect. So if 
you have a field named "First Name" in your database, the name you'll use in your 
tag will be "First_Name".
First introduced in version 1.0.
Version 1.7 introduced the optional raw attribute.
Version 1.8 introduced the optional nolink attribute.
Version 2.1 introduced the optional cgiEncoded attribute.
Version 2.3 introduced the optional replace attribute.
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4W WebMerge Tag Reference

WM-ImagePath
Syntax [WM-ImagePath: fieldName]

[WM-ImagePath: fieldName nolink]

Examples [WM-ImagePath: ImageFile]

[WM-ImagePath: ImageFile  width="100" height="100]

Description The [WM-ImagePath] tag is replaced by an <img> tag in the generated page, 
using the file path in the data of the field specified in fieldName as the src 
attribute.
In the example shown above, if your database includes a field named "ImageFile", 
you can include the path to an image file in that field. Using this tag, WebMerge 
will build an <img> tag, using the data in the database field as its source, like 
this:

<img src="images/mypicture.jpg">

When used in an index template, by default WebMerge generates all tags as links 
to the corresponding detail page. The optional nolink attribute is used in index 
pages to tell WebMerge to write the <img> tag without linking it to that detail 
page. If used in an detail page template, the nolink attribute is ignored.

Adding Image Attributes
HTML supports a variety of attributes for images, such as specifying the width or 
height of an image, its border size, and more. You can include these in your
WM-ImagePath tag. Anything between the end of the specified file and the closing
bracket ("]") is assumed to be your own HTML attributes, and are copied into the 
generated IMG tag for you.
For instance, the HTML WebMerge would generate from the last example above 
would look like:

<img src="image/mypicture.jpg" width="100" height="100">

Introduced in version 1.8.
Verison 2.4 introduced support for additional image attributes to be included with
the generated HTML.
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4W WebMerge Tag Reference

WM-Include
Syntax [WM-Include: filePath]

Example [WM-Include: parts/sidebar.html] 

Description [WM-Include] is replaced with the contents of another file, usually a a text or 
HTML format file. If the included file is in HTML format and a <body> tag is 
present, only the HTML between the <body> and </body> tags is included in your 
generated page, to avoid possible conflicts with your template's <body> tag.
The file specified in filePath is the full path to the local file in UNIX format, or a 
partial path relative to the location of the page being generated.
Files with names not ending in ".htm" or ".html" will be assumed to consist of plain 
text and will be translated into HTML, changing all non-ASCII characters to their 
corresponding character entity according to the ISO 8859-1 standard. For example, 
the character "<" becomes "&lt;". Files with names ending in ".htm" or ".html" will
be included "as is", with no character translation.
Introduced in version 2.0.



file:///Area%2051/4W/WebMerge/wm24/dev/4W%20...

54 of 91 2/10/05 2:23 PM

4W WebMerge Tag Reference

WM-FieldInclude
Syntax [WM-FieldInclude: fieldName]

Example [WM-FieldInclude: Field001] 

Description [WM-FieldInclude] uses a file path contained in the data from the field specified in 
fieldName to insert the contents of that file into your template.
This can greatly simplify your Web production workflow by allowing you to update 
content with WebMerge without altering your database.
For example, you could write a news article in any text editor and save it to a 
specific location, such as "/HardDrive/Folder/News.txt". Your field data then only
needs to include the path to that file, and using the WM-FieldInclude tag that data 
will be copied in place of the tag as the page is generated.
If the included file is in HTML format and a <body> tag is present, only the HTML 
between the <body> and </body> tags is included in your generated page, to 
avoid possible conflicts with your template's <body> tag.
The file specified in in the field data is the full path to the local file in UNIX format, 
or a partial path relative to the location of the page being generated.
Files with names not ending in ".htm" or ".html" will be assumed to consist of plain 
text and will be translated into HTML, changing all non-ASCII characters to their 
corresponding character entity according to the ISO 8859-1 standard. For example, 
the character "<" becomes "&lt;". Files with names ending in ".htm" or ".html" will
be included "as is", with no character translation.
Introduced in version 2.2.
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4W WebMerge Tag Reference

WM-Record
Syntax [WM-Record]

... Html to be replicated for each record
[/WM-Record]

[WM-Record width=width cols=cols]
 ... Html to be replicated for each record

[/WM-Record]

Examples <body>
<table border="0" width="400">
[WM-Record]
 <tr>
  <td>[WM-Field: Name]</td>
  <td>[WM-Field: City]</td>
  <td>[WM-Field: State]</td>
 </tr>
[/WM-Record]
</table>
</body>

<body>
[WM-Record cols=2 width=500]
[WM-ImagePath: ProductImage]
[/WM-Record]
</body>  

Description This tag is used only in index templates.
The HTML between the [WM-Record] and [/WM-Record] tags will be replicated 
once for each record in your export file. The data within the WM-Record tags can 
contain WM-Field and other tags, so you can pretty much make any layout you 
want.
If your template used the first example shown above, the page WebMerge 
generates will look something like:

<body>
<table border="0" width="400">
<tr>
 <td>Richard Gaskin</td>
 <td>Los Angeles</td>
 <td>CA</td></tr>
<tr>
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 <td>Joe Schmoe</td>
 <td>Faketown</td>
 <td>PA</td></tr>
<tr>
 <td>Jane Doe</td>
 <td>Anytown</td>
 <td>MO</td>
</tr>
</table>
</body>

Any tags in an index page that are outside of [WM-Record] and [/WM-Record] tags 
will be processed only once, using the data from the last record processed for that 
page.
You can include any number of WM-Record tag pairs in a template, allowing you to 
have discontiguous layouts if needed.
If you want your records displayed in a multi-column format you can specify the 
number of columns with the cols attribute. This will cause WebMerge to generate 
a table around your records with the number of columns you specify, with each cell 
being top-aligned.
When using the cols attribute you can also specify the total width of the table with 
the width attribute. This will create a table of a fixed width, with each cell width 
being of fixed equal size.
If your template used the second example above, your generated code would look 
something like this:
     <body>
     <table width="500">
     <tr>
      <td width="250" valign="top">
      <a href="products/product001.html">
       <img src="images/product001.jpg" border=0></a>
      </td>
      <td width="250" valign="top">
      <a href="products/product002.html">
       <img src="images/product002.jpg" border=0></a>
     </td>
     <tr>
      <td width="250" valign="top">
      <a href="products/product003.html">
       <img src="images/product003.jpg" border=0></a>
      </td>
      <td width="250" valign="top">       <a href="products/product004.html">
       <img src="images/product004.jpg" border=0></a>       </td>
     </tr>
     </table>      </body>

Introduced in version 1.5.
Version 2.0 introduced the ability to have multiple WM-Record tags in a given
index template.
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Version 2.2 introduced the table-generation attributes.
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4W WebMerge Tag Reference

WM-AccessLink
Syntax [WM-AccessLink: fieldName]

[WM-AccessLink: fieldName base="url"]

Example [WM-AccessLink: Products base="http://www.fourthworld.com/products/"]

Description The [WM-AccessLink] tag is used to insert the contents of the field specified in fieldName 
data is in Microsoft Access Link type format.
Microsoft Access supports a field type called "link" that when exported contains the display text, link URL, 
and optional link title text separated by "#" characters, e.g.:

Fourth World#http://www.fourthworld.com/index.html##4W Home Page

With the WM-AccessLink tag WebMerge will convert that data to: 
<a href="http://www.fourthworld.com/index.html" 

                                                        title="4W Home Page">Fourth World</a>

Using the base attribute
The optional base attribute allows you to specify a partial URL that will be prepended to the URL in the 
field data. For example, if your link data contains "products/webmerge.html" and your base value is 
"htp://www.fourthworld.com", the link will be generated as:

<a href="http://www.fourthworld.com/products/webmerge.html">

                                                        Fourth World</a>

Note that the portions of the field data used for both the link label and title text are converted to HTML. 
The conversion changes all non-ASCII characters to their corresponding character entity according to the 
ISO 8859-1 standard. For example, the character "<" becomes "&lt;".

First introduced in version 2.3
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4W WebMerge Tag Reference

ROUGHT DRAFT
WM-Wiki

Syntax [WM-Wiki: fieldOrFileName]

Example [WM-Wiki: wiki_field]
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Description The [WM-Wiki] tag is replaced by the contents of the specified field, expanded from shorthand 
"wiki" syntax to full HTML according to the rules specified below.
"Wiki" is Hawaiian for "quick", and the term has become popular in computing to refer to a way 
of using shorthand syntax for creating web pages. For example, a standard HTML link to the 
Fourth World web site looks like:
 <a href="http://www.fourthworld.com">http://www.fourthworld.com</a>

But using wiki syntax you can have a database field that contains simply:
  [http://www.fourthworld.com]                                          

Or if you want to link to a book at Amazon.com like this:
 <a href="http://www.amazon.com/exec/obidos/ASIN/155860569X/fourthworld/">Buy This Book</a>

...you could just write:
 [Buy This Book > ISBN:0670058874]

You get the idea: the goal here is to provide a way that you can type simple shorthand to make 
parts of pages rather than cumbersome HTML. In a publishing workflow using WebMerge, you
can author content by entering wiki content into your database and let WebMerge generate 
and post your pages from that.
Wiki syntax is very different from HTML, and while it's usually much simpler there is no 
standard among wiki tools. The wiki syntax WebMerge uses borrows from a number of
different wiki systems, with the goal of choosing the shortest and easiest to remember.

Links
To create a link to a resource, such as another web page, just put the full URL between 
brackets:
 [http://www.mysite.com]
 [mailto:me@mysite.com]
 [ftp://mysite.ftp]

This wil generate the URL pretty much as shown:
 <a href="http://wwww.mysite.com">http://www.mysite.com</a><br>
 <a href="mailto:me@mysite.com">mailto:me@mysite.com</a><br>
 <a href="ftp://somesite.ftp">ftp://somesite.ftp</a>

If you want the link label to be any text other than the URL itself, just put the label text before 
the URL, separated with ">" like this:
 [Click Here! > http://wwww.mysite.com]

...which will generate:
 <a href="http://wwww.mysite.com">Click Here!</a>
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Emphasis: Bold and Italic
To make text bold just enclose the text between "*" characters, so that this:
 An Example of *BOLD* text

...will generate this:
 An Example of <b>BOLD</b> text

To make text italic just enclose the text between "_" characters, so that this:
 An Example of _ITALIC_ text

...will generate this:
 An Example of <i>ITALIC</i> text

                                                        

                                                

Referring to Books
You can quickly link to any book in Amazon's catalog by just providing its ISBN number, where 
this:
 [ISBN:1234567879]

...will generate this:
 <a href="http://www.amazon.com/exec/obidos/ASIN/0670058874/fourthworld/">ISBN:1234567879</a>

Note the "/fourthworld/" part of the URL -- that's an ID for Fourth World's membership in 
Amazon's affiliate program. If you have your own Amazon ID you can add it to your wiki tag 
after the ISBN, separated by a slash like this:
 [ISBN:1234567879/myAmazonID]

By default simply having the ISBN will generated a very simple book citation as noted above.
But you can customize the label as with other links, by putting the label text before the ISBN 
number, sperated by ">":
 [My Book > ISBN:0670058874]

Lists
The WM-Wiki tag provides a simple way to implemented the two most popular list types: 
bullets and numbers.
To create a bullet list item, start a line with a Hyphen ("-") character.
To create a numbered list item, start a line with a number sign ("#") character.
With these rules, this:
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  #Step one
  #Step two
  #Step three

  -bullet 1
  -bullet 2
  -bullet 3

...generates this:
  <ul>
  <li type="1">Step one
  <li type="1">Step two
  <li type="1"> Step three
  </ul>
  <p></p>
  <ul>
  <li type="disc">bullet 1
  <li type="disc">bullet 2
  <li type="disc">bullet 3
  </ul>

Header Styles
Lines that start with an exclamation mark ("!") character are treated as headings. A single
exclamation mark generates as H3, with two generating larger as H2 and three generating 
even larger as H1, so that this:
  !Small Header
  !!Bigger Header
  !!!Biggest Header

...generates this:
  <h3>Small Header</h3>
  <h2>Bigger Header</h2>
  <h1>Biggest Header</h1>

Horizontal Rule
To add a horizontal rule across you page just start any line of text in your wiki data with four 
hyphens ("----").

Adding your own HTML
The WM-Wiki formatting rules will not be applied to anything between <html> tags, so you 
can add your own HTML in the middle of wiki data:
 [Mail Me! > mailto:me@mysite.com]
 <pre><img src="MyPic.jpg"></pre>
 [My favorite book > ISBN:1234567869]
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[http://www.mysite.com] [mailto:support@fourthworld.com]

The WM-Wiki tag was first introduced in version 2.4.
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4W WebMerge Tag Reference

WM-If
Syntax [WM-If: Value Operator Value]

...HTML if condition is true...
[/WM-If]

[WM-If: Value Operator Value ]
...HTML if condition is true...
[WM-Else]
...HTML if condition is false...
[/WM-If]

[WM-If: (Value Operator Value) AND (Value Operator Value) OR (Value Operator Value)]

Examples [WM-If: Field: ClientName = David]
 Hey David!
[/WM-If]

[WM-If: Field: Age <> ""]
This person is [WM-Field: Age] years old.
[/WM-If]

[WM-If CurrentRecordNumber mod 2]
 <tr><td bgcolor="gray">Gray Cell Color</td></tr>
[WM-Else]
 <tr><td bgcolor="white">White Cell Color</td></tr>
[/WM-If]

[WM-If: (Field: Age < 18) OR (Field: Age > 65)]
 You qualify for a discount
[WM-Else]
 The standard price applies
[/WM-If]  
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Description Along with the [WM-Else] and [/WM-If] tags, the [WM-If] tag controls what HTML will 
included into the generated page. The [WM-Else] tag is optional.
The tag arguments consist of two values compared by an operator. If the operator 
comparison evaluates to true, the HTML following the [WM-If] is written to the 
generated page. A space follows the operator, and everything after the operator is 
treated as the second value. If the comparison value is literal text, do not put quotes 
around it unless those quotes are present in your data.
If the optional [WM-Else] tag is used and the arguments evaluate to false, the HTML 
between the [WM-Else] and [/WM-If] tags will be written to the page instead.
Values can be any of the following:

Field: fieldName
The contents of the field specified in fieldName in the current record being 
processed.
Example: [WM-If: Field: ClientName .eq. David]
CurrentRecordNumber
An internal WebMerge variable that contains the number of the current record
being processed.
Example: [WM-If: CurrentRecordNumber > 10]
CurrentRecordCount
An internal WebMerge variable that contains the total number of records being
processes in the current set.
Example: [WM-If: CurrentRecordCount < 100]
IndexRecordNumber
The number of the record as it appears on the current index page, useful when
generating mutiple index pages.
Example: [WM-If: IndexRecordNumber < 100]
Any String or Number
WebMerge treats everything from the end of the operator to the closing right
square bracket (minus leading blanks) as the comparison value. Don't enclose 
literal values in quotes. If you include quotes, they're treated as part of the 
comparison value. Literal values are not case-sensitive and can include spaces 
within text or number values.
Example: [WM-If Field: FirstName = Steve]
The constant empty or ""
WebMerge will let you note an empty value with either the word empty or simply
two quotes with nothing between them.
Examples:
[WM-If: Field: Age = ""]
[WM-If: Field: Age = empty]

Operators make comparisons between the two values, and returns either true or false.
Operators can be written in either of two forms: WebMerge supports the FileMaker 
form for operators as well as its own form which may be simpler to remember.
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This table lists all operators in both supported forms:

WebMerge Form FMP Form Description Types
= .eq. equals All
<> .neq. does not equal All
> .gt. greater than number, date
>= .gte. greater than or equal to number, date
< .lt. less than number, date
<= .lte. less than or equal to number, date
contains .cn. contains string
DoesNotContain .ncn. does not contain string
IsIn .ii. is in string
IsNotIn .ini. is not in string
mod .mod. modulo number

The mod operator deserves a special note here, being perhaps the least obvious of the 
operators yet among the most valuable.
Mod simply determines whether there is a remainder when you divide the first value by 
the second. This is useful for determining a series of specific number of records, such 
as every fourth record or every tenth record.
For example if you wanted to have table cells created for each record by the 
WM-Record tag, but wanted every other record to have a different color, you could use 
mod to alternate portions of a WM-If tag like this:

[WM-Record]
[WM-If CurrentRecordNumber mod 2]
...even-numbered records are made from this HTML...
[WM-Else]
...odd-numbered records are made from this HTML...
[/WM-If]
[/WM-Record]

By default, operators compare the two values as text unless both of them are numbers,
in which case the comparison is performed numerically.
The mod operator is an exception to this rule, as it requires that both values are 
numbers, and will log an error if an attempt is made to apply it to textual data.
If you want to compare two values as dates, you can specify that the operator use a 
date comparison by adding ":date" to the operator:

[WM-If Field: BirthDate >:date 11/22/63]

Date values are evaluated according to the format in use on the computer WebMerge is 
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running on. This format is set in the operating system's Date control panel.

Multiple Criteria

With WebMerge v2.4 and later you can specify multiple criteria for evaluation, with each 
criteria enclosed in parentheses: 
 [WM-If: (Field: Age < 18) OR (Field: Age > 65)]

You can have up to 16 criteria, and can use parentheses to force some expressions to 
evaluate before others (as with alebra, expressions more deeply nested in parentheses 
will be evaluated first):
 [WM-If: ((Field: Age < 18) OR (Field: Age > 65)) AND (Field: FrequentFlyer = true)]

Introduced in WebMerge 2.0.
Version 2.1 introduced the IndexRecordNumber value.
Version 2.4 introduced support for multiple evaluation criteria.
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4W WebMerge Tag Reference

WM-IndexLabel
Syntax [WM-IndexLabel: FieldName]

  ...HTML when field value changes
[/WM-IndexLabel]

Examples [WM-Record]
  [WM-IndexLabel: State]
   <tr>
     <td><h2>[WM-Field: State nolink]</h2></td>
     <td></td>
   </tr>
  [/WM-IndexLabel]
   <tr>
     <td width="80">[WM-FIELD: Code nolink]</td>
     <td>[WM-FIELD: Name]</td>
     </tr>
[/WM-Record]

Description This tag is used only on index pages.
The [WM-IndexLabel] tag lets you write a portion of an index page only when the 
value in the specified field changes between records. This is especially useful for 
labelling groups of records on the page.
The [WM-IndexLabel] tag is used between [WM-Record] tags and is processed for 
each record in your source file. Any HTML between the [WM-IndexLabel] and 
[/WM-IndexLabel] tags is included if the data in the specified field has changed 
since the last record processed, or if the record being processed is the first one on 
the index page. If neither of these conditions is met, nothing is written in place of 
those tags. The HTML between the tags can include other WebMerge tags, as 
shown in the example above.
NOTE: If you're using WM-IndexLabel in conjunction with WM-Record, you'll 
probably want to put WM-IndexLabel before the WM-Record tag. This is because
WM-Record will process every record in the source file, but WM-IndexLabel will 
only process records when the value in the specified field changes. This is 
especially important when using the multi-column option for WM-Record, as it will 
create a new cell for each record but WM-IndexLabel will tell WebMerge not to 
write anything into a cell unless the value in its field changes, giving you blank 
cells on your index page. 
Introduced in WebMerge 2.1.
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4W WebMerge Tag Reference

WM-LinkFirst
Syntax [WM-LinkFirst] Link Label [/WM-LinkFirst]

Example [WM-LinkFirst]Go to First Record[/WM-LinkFirst]

Description This tag is used only in detail templates.
The HTML between [WM-LinkFirst] and [/WM-LinkFirst] is replaced with a link to 
the page generated from the first record in the export file.
If the current page is being generated from the first record, the text between the 
opening and closing tags is not written to the generated page.
Used in conjunction with WM-LinkPrevious, WM-LinkNext, and WM-LinkLast you 
can easily build page-to-page navigation into your detail pages.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkFirst: target="_blank"]First Page[/WM-LinkFirst]

...which would generate:
   <a href="page002.html" target="_blank">First Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.



file:///Area%2051/4W/WebMerge/wm24/dev/4W%20...

70 of 91 2/10/05 2:23 PM

4W WebMerge Tag Reference

WM-LinkPrevious
Syntax [WM-LinkPrevious] Link Label [/WM-LinkPrevious]

Example [WM-LinkPrevious]Go to Previous Record[/WM-LinkPrevious]

Description This tag is used only in detail templates.
The HTML between [WM-LinkPrevious] and [/WM-LinkPrevious] is replaced with a 
link to the page generated from the previous record in the export file.
If the current page is being generated from the first record, the text between the 
opening and closing tags is not written to the generated page.
Used in conjunction with WM-LinkPrevious, WM-LinkNext, and WM-LinkLast you 
can easily build page-to-page navigation into your detail pages.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkPrevious: target="_blank"]Prev Page[/WM-LinkPrevious]

...which would generate:
   <a href="page002.html" target="_blank">Prev Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkNext
Syntax [WM-LinkNext] Link Label [/WM-LinkNext]

Example [WM-LinkNext]Go to Next Record[/WM-LinkNext]

Description This tag is used only in detail templates.
The HTML between [WM-LinkNext] and [/WM-LinkNext] is replaced with a link to 
the page generated from the next record in the export file.
If the current page is being generated from the last record, the text between the 
opening and closing tags is not written to the generated page.
Used in conjunction with WM-LinkFirst, WM-LinkNext, and WM-LinkLast you can 
easily build page-to-page navigation into your detail pages.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkNext: target="_blank"]Next Page[/WM-LinkNext]

...which would generate:
   <a href="page002.html" target="_blank">Next Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkLast
Syntax [WM-LinkLast] Link Label [/WM-LinkLast]

Example [WM-LinkLast]Go to Last Record[/WM-LinkLast]

Description This tag is used only in detail templates.
The HTML between [WM-LinkLast] and [/WM-LinkLast] is replaced with a link to 
the page generated from the last record in the export file.
If the current page is being generated from the last record, the text between the 
opening and closing tags is not written to the generated page.
Used in conjunction with WM-LinkPrevious, WM-LinkNext, and WM-LinkFirst you 
can easily build page-to-page navigation into your detail pages.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkLast: target="_blank"]Last Page[/WM-LinkLast]

...which would generate:
   <a href="page024.html" target="_blank">Last Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkIndex
Syntax [WM-LinkIndex] Link Label [/WM-LinkIndex]

Example [WM-LinkIndex] Back to List [/WM-LinkIndex]

Description This tag is only used in detail templates.
The HTML between [WM-LinkIndex] and [/WM-LinkIndex] is replaced with a link to 
the index page that links to the page being generated.
If no index pages are being generated, this tag is ignored.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkIndex: target="_blank"]Index Page[/WM-LinkIndex]

...which would generate:
   <a href="index.html" target="_blank">Index Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkIndexFirst
Syntax [WM-LinkIndexFirst] Link Label[/WM-LinkIndexFirst]

Example [WM-LinkIndexFirst]Go to First Category[/WM-LinkIndexFirst]

Description This tag is only used in index templates.
The HTML between [WM-LinkIndexFirst] and [/WM-LinkIndexFirst] is replaced with 
a link to the first index page generated.
If the current index page being generated is the first one, the text between the 
opening and closing tags is not written to the generated page.
The WM-LinkIndexFirst tag provides a way to navigate among multiple index 
pages. For example, if you were publishing an employee directory you could have 
WebMerge create a new index whenever the first letter in the Last_Name field 
changes, and this tag would let you move to the list of names starting with "A".
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkIndexFirst: target="_blank"]First Page[/WM-LinkIndexFirst]

...which would generate:
   <a href="index001.html" target="_blank">First Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkIndexPrevious
Syntax [WM-LinkIndexPrevious] Link Label[/WM-LinkIndexPrevious]

Example [WM-LinkIndexPrevious]Go to Previous Category[/WM-LinkIndexPrevious]

Description This tag is only used in index templates.
The HTML between [WM-LinkIndexPrevious] and [/WM-LinkIndexPrevious] is 
replaced with a link to the first index page generated.
If the current index page being generated is the first one, the text between the 
opening and closing tags is not written to the generated page.
The WM-LinkIndexPrevious tag provides a way to navigate among multiple index 
pages.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkIndexPrevious: target="_blank"]Prev Page[/WM-LinkIndexPrevious]

...which would generate:
   <a href="page002.html" target="_blank">Prev Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkIndexNext
Syntax [WM-LinkIndexNext] Link Label[/WM-LinkIndexNext]

Example [WM-LinkIndexNext]Go to Next Category[/WM-LinkIndexNext]

Description This tag is only used in index templates.
The HTML between [WM-LinkIndexNext] and [/WM-LinkIndexNext] is replaced with 
a link to the first index page generated.
If the current index page being generated is the last one, the text between the 
opening and closing tags is not written to the generated page.
The WM-LinkIndexNext tag provides a way to navigate among multiple index 
pages.
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkIndexNext: target="_blank"]Next Page[/WM-LinkIndexNext]

...which would generate:
   <a href="page003.html" target="_blank">Next Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-LinkIndexLast
Syntax [WM-LinkIndexLast] Link Label[/WM-LinkIndexLast]

Example [WM-LinkIndexLast]Go to Last Category[/WM-LinkIndexLast]

Description This tag is only used in index templates.
The HTML between [WM-LinkIndexLast] and [/WM-LinkIndexLast] is replaced with 
a link to the last index page generated.
If the current index page being generated is the last one, the text between the 
opening and closing tags is not written to the generated page.
The WM-LinkIndexLast tag provides a way to navigate among multiple index 
pages. For example, if you were publishing an employee directory you could have 
WebMerge create a new index whenever the first letter in the Last_Name field 
changes, and this tag would let you move to the list of names starting with "Z".
All navigation tags allow you to include attributes in the tag which will be included 
in the generated link. For example, to specify a target in a navigation tag you'd 
write:
   [WM-LinkIndexLast: target="_blank"]Last Page[/WM-LinkIndexLast]

...which would generate:
   <a href="index004.html" target="_blank">Last Page</a>

Introduced in version 2.0.
Version 2.2 introduced support for link attributes.
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4W WebMerge Tag Reference

WM-CurrentRecordCount
Syntax [WM-CurrentRecordCount]

Example Total number of records in the database is [WM-CurrentRecordCount]

Description [WM-CurrentRecordCount] is replaced with the total number of records being 
processed.
If you're using the free demo version, the number will reflect the maximum number 
of recrds WebMerge will process in demo mode, 20. When running WebMerge with
the Test Mode option on, this number will not exceed the number specified in the 
popup control for that option in the main WebMerge window (10, 20, 50, 100, 500, 
or 1000 records).
Introduced in WebMerge 2.0.
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4W WebMerge Tag Reference

WM-CurrentRecordNumber
Syntax [WM-CurrentRecordNumber]

Example The number of this record is [WM-CurrentRecordNumber]

Description [WM-CurrentRecordNumber] is replaced with the record's position in the set of 
records being processed.
Introduced in WebMerge 2.0.
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4W WebMerge Tag Reference

WM-IndexRecordNumber
Syntax [WM-IndexRecordNumber]

Example This is record [WM-IndexRecordNumber] of this list.

Description [WM-IndexRecordNumber] is replaced with the record's position in the set of 
records displayed on the current index page.
This is useful when generating multiple index pages where you want to display the 
number of the record as it appears on that page, as opposed to 
[WM-CurrentRecordNumber], which is the number of the currently processed 
record relative to all records being processed.
Introduced in WebMerge 2.1.
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4W WebMerge Tag Reference

WM-CurrentRangeStart
Syntax [WM-CurrentRangeStart]

Example Showing records [WM-CurrentRangeStart] to [WM-CurrentRangeEnd]

Description [WM-CurrentRangeStart] is replaced with the beginning of the range of records on 
the index page currently being generated.
For example, if you have set up WebMerge to generate a new index page every 20 
records, this tag as shown in the example above will be "1" on the first index page, 
"21" on the next, etc.
This tag works for all index pages created with any of the options in WebMerge's 
Index tab. If you're building a single index page then [WM-CurrentRangeStart] will
be 1, and [WM-CurrentRangeEnd] will be the total number of records being 
generated.
Introduced in WebMerge 2.1.
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4W WebMerge Tag Reference

WM-CurrentRangeEnd
Syntax [WM-CurrentRangeEnd]

Example Showing records [WM-CurrentRangeStart] to [WM-CurrentRangeEnd]

Description [WM-CurrentRangeEnd] is replaced with the beginning of the range of records on 
the index page currently being generated.
For example, if you have set up WebMerge to generate a new index page every 20 
records, this tag as shown in the example above will be "20" on the first index 
page, "40" on the next, etc.
This tag works for all index pages created with any of the options in WebMerge's 
Index tab. If you're building a single index page then [WM-CurrentRangeStart] will
be 1, and [WM-CurrentRangeEnd] will be the total number of records being 
generated.
Introduced in WebMerge 2.1.
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4W WebMerge Tag Reference

WM-GenDate
Syntax [WM-Gendate]

[WM-Gendate short]

[WM-Gendate long]

[WM-Gendate abbreviated]

[WM-Gendate internet]

[WM-Gendate system]                                     

Example This page was updated on [WM-GenDate short system].

Description [WM-GenDate] inserts the current date. By default it uses MM/DD/YY, but other
formats can be specified with these attributes:

Attribute Example Result
short 12/25/02
long Wednesday, December 25, 

2003
abbreviated
(can also be "abbrev" or
"abbr")

Wed. Dec 25, 2003

internet Wed, 25 Dec 2003 23:44:37 
-0800

The system attribute can be used in conjunction with any of the above to 
generated the date in the format specified on your system at the time your pages 
are generated:
   [WM-GenDate long system]

Without the system attribute WebMerge will use the US formats shown above.
Introduced in version 2.1.
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Example: Contact List
The Contact List example files are located in the Example Files folder, inside of the folder containing 
the WebMerge application.
For this example we decided to give WebMerge a modest workout, using a database of contact 
information for the 540 members of the US Congress as the sample data set, with most of the 
WebMerge template tags available. On a 800MHz computer, WebMerge completed this task in under 
twelve seconds.
You can view the sample database here:

Contact List - US Congress
Here is a list of the files installed in the WebMerge_Examples folder that you can use to generate 
these pages yourself:
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Example: Image Gallery
The Fourth World offices are located in the world's largest artists' colony, located in downtown Los 
Angeles. One of our neighbors, Christian Ristow, creates large robots and does performances with
them, having them attempt to destroy each other with three-foot claws, built-in flamethrowers, and 
other entertaining options.
We've taken a good number of photo of these shows, and keep them in a database. We exported 
images from a show done here a couple years ago as an example of how WebMerge lets you work 
with image paths and how use the target link attribute for managing links within frame sets.
You can view the image gallery here:

Image Gallery- Robot Performance Art
Here is a list of the files installed in the WebMerge_Examples folder that you can use to generate 
these pages yourself:
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Example: Journal
WebMerge makes a handy solution for publishing your personal journals, collections of articles, etc.
The WebMerge installation includes two journals, using Mark Twain's "Adam's Diary" and "Eve's Diary" 
(downloaded from the wonderful Project Gutenberg site) as examples.
You can view each of these examples using these links:

Adam's Diary Eve's Diary

The files needed to generate these are show below, found in the WebMerge_Examples folder. Each 
includes a copy of a cross-platform FileMaker Pro database for your reference, and the exported 
Merge file, template pages, and settings files that you can examine to learn how they were set up.
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4W WebMerge Technical Support
All WebMerge users can access our support page for WebMerge, located at:

http://www.fourthworld.com/products/webmerge/support.html
Registered users are eligible for personal support via email and telephone for one year from data of 
purchase.
If you need technical assistance, send an email to support@fourthworld.com, or use the WebMerge 
Feedback Form from our Web site.
When submitting a technical support question, please note the following information in your email:

WebMerge version
Operating system version
Make and model of computer
Total amount of RAM installed
A complete description of the problem, with steps needed to reproduce it
Your registration number

The more complete your information, the better we are able to address your question quickly and 
completely.
For your convenience, you can get a complete list of current system info by choosing "System Info..." 
from WebMerge's Help menu. A button in WebMerge's System Info window lets you quickly copy that 
info so you can paste it into your email.

WebMerge FAQ
We maintain a list if frequently-asked questions (with answers of course) at the Fourth World Web 
site. This list is updated often, so if you have a question it's worth checking there first.
The WebMerge FAQ is available at:
http://www.fourthworld.com/products/webmerge/webmergefaq.html
If you have a question not addressed there, drop us a note at webmerge@fourthworld.com or use the 
WebMerge Feedback Form.

New Versions of WebMerge
WebMerge is updated frequently, on the average of about every other month. Updates include bug 
fixes and new features, so you may want to check out the WebMerge Download Page for the very 
latest. Most updates are free to registered users, and you will be able to use your current license 
code in newly-downloaded versions.
The WebMerge Download Page is located at:
http://www.fourthworld.com/products/webmerge/download.html
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About Fourth World Media Corporation
We've been building interactive media and tools since before the Web was invented.
Today Fourth World delivers rich-media applications for Mac OS, Windows, UNIX, and the World Wide 
Web. No matter where your audience is, if they have a computer we can help you reach them.
The details of our work are driven by a passion for usability, with our sights always focused on 
maximizing our client's return on investment.
Most of our clients have retained us for long-term maintenance and enhancements after we've 
successfully delivered their project. Several have invited us to assist them in other areas of their 
businesses as well, including database systems for support, project management solutions, and 
other workflow enhancements.
We think software is fun. We're here to help businesses deliver some of that fun to their customers.
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WebMerge Affiliate Program
The Fourth World Affiliate Program lets you earn commissions from sales of Fourth World products 
simply by referring visitors to our site. You can set up an Affiliate account for free in just a couple 
minutes, and we'll provide you with a special link to include at your site so we can track your 
referrals. Details of the program are outlines below.

Sign Up For Our Affiliate Program

If you already have an affiliate account you can log in here.

What is an Affiliate?

A Fourth World Affiliate is a website that earns sales commissions simply by sending visitors to our 
site. We'll supply you with a special link to our site which identifies you as the affiliate referrer. 
When one of your users clicks on that link, they arrive at our online storefront. If they make a 
purchase, you earn a commission. We handle the tracking, transaction processing, fulfillment, and 
customer service.

How much can an Affiliate earn?

Fourth World pays a 15% commission on all paid purchases made by users who came to 
FourthWorld.com directly from an authorized, approved text or graphic link on your website. Taxes 
are not included in calculation, and of course the commission only applies to new sales you generate 
and not purchases made by Affiliate members themselves. Commissions are paid on the first of each 
month, provided your accrued commissions total at least $25. If accrued commissions are less than 
$25, they are held over for the following month, until the total is at least $25. There is no limit to the 
amount of sales commissions that you can earn as a Fourth World affiliate.

How do I link my Web site to get commissions?

All you need to do is either place a text link, a banner, or small image of our logo on your website. 
We have an automatic HTML generator that will give you your link code upon signing up for your 
account. You can then cut and paste this code into your web pages. It is very easy to use, even new 
webdesigners can copy and paste to create links with ease. After your complete your free 
registration, you just log in to your Affiliate account and get your link code that you paste into your 
site.

Can I use graphic links?

Yes. We have several to choose from on our WebMerge graphics page.

How are the Affiliate referrals tracked?

We use the Miva Merchant shopping system to tracks all referrals and purchases on our website, one 
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of the most widely installed and respected shopping cart systems on the internet. Referrals are 
tracked based on the customers' shopping baskets with a cookie that is created on their computer 
each time they access our storefront.

How do I know how much I've earned?

You can log in to your account at any time to track sales and traffic activity. The Affiliate Program 
updates your account in real time, so you'll know right away when commissions have been earned.

What If I have Questions About Links from my Site To Fourth World?

If you have questions about setting up links or merchandising our products, please email us at 
affiliates@fourthworld

How much does it cost to join the Affiliate Program?

The Fourth World Affiliate Program is completely free, and there is no minimum sales requirements. 
All it takes is a little time to put our link on your website, and recommend that people come and 
check us out.

How do I sign up?

After you complete our online Sign-up Now form, you’ll be emailed a confirmation of your new
account.

Sign Up For Our Affiliate Program

If you already have an affiliate account you can log in here.

SetWriteURLsAsLinks "<Boolean>"
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